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Welcome! 
 

This reference manual was written to make the start with the software easier; moreover, it 
shows all the perspectives for usage with different hardware sensors to efficiently solve 
complex practical tasks. As next the license terms are represented, followed by the table of 
contents. The first chapter concentrates on the main purpose and some highlights of Gart-
2000® navigation .The next chapter offers you step by step guide of the installation process, 
followed with introduction of the graphical user interface. The menu control with all 
corresponding functions are described in the last chapter. 

 

For future questions or help please write us to: 

software@allsat.de 

or visit our homepage: 

www.allsat.de 
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License terms 
 
By the lawful purchase of the Gart-2000® navigation software and the manuals belonging to 
it the licensee is entitled to the use of these objects in compliance with the following specified 
license terms. The licensee agrees to accept the license terms and to keep to them as soon 
as the software Gart-2000® navigation is executed. 
  
§1 Object of the License 
  
The Allsat GmbH network+services claim all rights (licenser) to the software Gart-2000® 
navigation. In accordance with these license terms the licenser gives the non-exclusive and 
the non-applicable right (license) to use this software and the documentation to the licensee. 
  
The licenser has got the right to update or revise the layout and the contents of this software. 
  
Products that are updated or revised are also subject to the provisions of this contract. 
  
§2 Rights of Use, Misuse 
  
The licensee accepts the licenser’s rights to the product (patents, copyrights, trademarks, 
business secrets) unrestrictedly. That also includes the exclusive copyright on all analog and 
digital documentation. It is allowed to make copies of the product and documentation if this is 
necessary for backup purposes. 
  
The right to use comprises the execution of the software with only one computer. 
  
It is not allowed to: 
  
- use one license of the software with more than one computer at the same time,  
  
- change the functionality or the design of the software, 
  
- pass the software or the documentation on to third (for example sale, letting, hiring out or 
free passing on) 
  
Every not-licensed use is a violation of the licenser’s patent rights and, therefore, can be 
prosecuted. 
  
The licensee agrees to arrange all necessary steps to protect the licenser’s rights and, 
especially, to prevent the unauthorized use, multiplication, passing on and publication of the 
software. 
  
§3 Support 
  
If training is part of the sales-contract, the licensee has got the right to the following support 
service offered by the licenser (this support service is limited to three month after the 
delivery): 
  
- Free updates of the software Gart-2000® navigation and all documentation 
  
- Hotline advice in case of problems with the use of the software. 
  
- Moreover, the licenser offers software-support contracts. 
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§4 Liability and Guarantee 
  
The software is tested and - assuming appropriate use - checked. The licenser does not give 
a guarantee of the respective use of the licensee. 
  
The licensee has to inform the licenser of bugs in the software immediately. Patches or the 
replacement of the faulty software is guaranteed. 
  
The licensee will only have the right for restitution or reduction of the software price if the 
patches or the replacement fails within an adequate period of time (at least 4 weeks). The 
licenser does not give a guarantee of further indirect damages. 
  
All claims to guarantee expire 12 months after the delivery. 
  
The licenser is appreciative for all suggestion for improvement. 
  
§5 Validity 
  
The right of use comes into effect when the licensee pays the license fee to the licenser. The 
license is given for an indefinite duration. 
  
If the right of use is not exercised any longer by the licensee or if it is revoked the licensee 
has got the duty to destroy all software and its documentation which he is in possession of or 
to send them - at his expense - back to the licenser. Moreover, the licensee has got the duty 
to preserve the licenser’s patent rights even if he does not use the software any longer. 
  
§6 Rights of other Companies 
  
Trademarks and company names of foreign companies are used without of the guarantee of 
free use. The licenser does not guarantee that described programs, circuitry, assembly, 
processes etc. are free from patent rights of third. 
  
§7 Final provisions 
  
All modifications or completions of these license terms are only effective if they are in written 
form. 
  
Even if some provisions of these license terms are ineffective, the others still are effective. 
Ineffective provisions have to be replaced by others that correspond to the general purpose 
of the license terms. 
  
The law of the Federal Republic of Germany is applied to this license agreement.  
  
Any disputes arising hereunder will be settled before a court of law in Hannover, Germany. 
  
  
Allsat GmbH network+services,  
 
Hannover, 24. October 2006 
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1 Product specification and special futures 
 
The Gart-2000® navigation software is build as flexible, free extendable platform to control, 
monitor and analyze complex measurement hardware. Furthermore it provides options for 
effective integration of multi sensor systems, such as JNS Gyro-4 + JNS IMU, etc. 
Distinguishing characteristics for that software system are summarized as follows: 
 

 Multi sensor, hardware independent platform 
 
 Extendable module-based architecture for fast implementation of customer 

requirements 
 

 Effective Real- time and post processing functionalities 
 

 Scalable User Interface 
 

 Simple project administration 
 

 Intuitive message management 
 

 Secure data logging 
 

 Comprehensive viewing options 
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2 Getting started with Gart-2000® navigation 
 

2.1 System Requirements 
 
The Gart-2000® navigation software package runs on Microsoft® Windows® NT/2000/XP. 
For communication with hardware sensors a serial RS232-port is needed. Furthermore we 
recommend using an “USB2COM” adapter to emulate several serial ports to communicate 
with multi sensor hardware-systems. 

 
 

2.2 Installation  
 
The delivered Gart-2000® navigation installation CD includes the runnable SETUP.EXE file. 
To start the installation routine, execute this file and submit the instructions as follows: 
 
 

 
 
Picture 1.1 Installation – Step 1 
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The license agreement from Gart-2000® navigation is shown in the next step. After viewing 
you must commit the license agreement to continue the installation process.  
 

 

 
 
Picture 1.2 Installation – Step 2 
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The next dialog requests your name, company and the product serial number. The installer 
tries to query this information automatically. On errors please correct the input and pres the 
“Next” button to continue.  
 
Notice: The edit field for the serial number accepts input of any random numbers. Please type 
one digit to continue. For more information about licensing please refer to chapter 2.3.4 
Version information and licensing procedure
 

 

 
 

 
Picture 1.3 Installation – Step 3 
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Please choose the destination folder or click “Next” to install Gart-2000® navigation to the 
default target folder. 
 
 

 
 
Picture 1.4 Installation – Step 4 
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The next dialog presents short overview of all installation components in detail with their size 
in KB included. Please click “Next” to continue. 
 
  

 
 
Picture 1.5 Installation – Step 5 
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Please choose program folder, where shortcuts to program executables etc. are copied or click 
“Next” for default. Afterwards the installer continues coping the program files according to 
your selections.  
 
 

 
 
Picture 1.6 Installation – Step 6 
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Progress bar indicators are shown during the copy process. When coping files is done, the 
installer automatically opens the program group directory with program shortcuts in order to 
directly start using your new software. 
 
 

 
 
Picture 1.7 Installation – Step 7 
 

2.2.1 Installation repository 
 
Following files and directories are copied/created by the installation routine: 
 
Program main directory, executable , libraries, system-db, etc.: 
 
..\GART-2000 navigation 
 
Demo projects: 
 
..\GART-2000 navigation\Demo_JNSGyro4\GART2000NaviPrj.mdb 
..\GART-2000 navigation\Demo_JNSGyro2\GART2000NaviPrj.mdb 
..\GART-2000 navigation\Demo_JNSLexon\GART2000NaviPrj.mdb 
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Script files: 
 
..\GART-2000 navigation\Script\Gyro2 
..\GART-2000 navigation\Script\Gyro4 
..\GART-2000 navigation\Script\Lexon 
 

2.3 Graphical User Interface and program structure 
 
Gart-2000® navigation is specially designed to provide simple handling and intuitive 
workflow. Even complicated application tasks are mapped into user friendly interface, in 
order to focus to your main goal and avoid dealing with producer-sided details.  
Reducing human errors by using complex manufacturer-proprietary interfaces, Gart-2000® 
navigation offers you more safety, to make full advantage of your hardware systems. 

 
 

2.3.1 Projects 
The program starts with “Open / Create Project” dialog box, where you can either choose 
existing one, or create new project:  
 
 

 
 
Picture 1.8 Open / Create Project 
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Each project includes one or more Gart-2000® navigation modules and corresponding 
always to one database file called “GART2000NaviPrj.mdb”. Entering a project name will 
create a new or open existing one. On new, same named project folder is created where all 
project files e.g. “GART2000NaviPrj.mdb” are stored. 

2.3.2 Multi document environment 
According the expectations of extendable software system, Gart-2000® navigation was 
designed with multi document interface as basic architecture alignment. Consequently it 
combines several software modules within his main frame, providing more flexibility and 
scalability dealing with your application. 

 
 

 
 
Picture 1.9 Select Modules 
 
For example you can synchronously load and run two or more modules in one program 
environment such as “JNS Gyro-4” with any other measurement sensor. The multi document 
interface allows also breaking down of specific modules e.g. JNS Gyro-4 to sub-modules with 
their own control elements and views.  
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2.3.3 Program Interface  
 
An overview of important control elements of the user interface are showed in the picture 
below: 
 

 

Title bar of one  
application module-
window Status bar of one  

module window and  
the main application 

Menu- and toolbar of  
currently selected  
module 

Title bar of one 
module view- 
window 

Title bar of the  
main application-
window  

 
Picture 2.0 Global View 
 
The program interface consists of several control and view elements for effective handling, 
graphical displaying and monitoring issues. All the menu-, tool- and status bars, containing 
pushbuttons and other operating devices count to the user controls. 
Every single control element and his action depends on the module you currently selected. 
General overview of all loaded modules and sub- modules is available at the main menu 
“Window”. There are several ways to see which module is currently selected. The name is 
displayed on the program main title bar, its also marked with checkmark on the main menu 
“Window”, finally the highlighted window indicates the active module.  
Assuming that two different modules are loaded: “JNS Gyro-4” and “JNS IMU”, hitting the 
button “Initialise” on the toolbar, will consequently initialise only the currently selected one 
e.g. “JNS Gyro-4”.  
Unlike the user controls all view elements are responsible for displaying relevant information 
about application events and contents. Each view is placed in separate window with standard 
options to move, close, minimize or maximize, so you can scale them corresponding to your 
needs. 
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 Generally the view elements are classified in two categories: 
 Main View: This view combines output of several program modules. 

Spanning various information of different modules it provides options for 
global comparisons and analyses. 

 Module View: Displaying relevant information about e.g. attitude or velocity 
of every embedded measurement sensor, this type of views correspond to 
every single module, to provide module- specific visualizations.  

 
 

2.3.4 Version information and licensing procedure 
 
Information about build number, release and producer are accessible at following menu: 
“?\About”, as shown on the picture bellow: 
 
 

 
 
Picture 2.1 About dialog 
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The license state and all available modules, as well as activation options are showed at the 
program menu “?\License”:  
 
 

 
 
Picture 2.2 Licensing 
 
The software Gart-2000® navigation comes as time-limited demo version. Please contact 
your distributor to acquire your user key for unlimited license activation. For this purpose the 
“GART-2000 S/N” is needed. You will receive unique user key, that is soft- and hardware 
bound on your computer and the purchased program-modules. 
After entering the 15-digit user key please click “Submit” to validate your input and 
accomplish the activation task. Short confirmation message depending on the result of 
activation is shown after that. On success the license mode is switched to “valid” and the 
expiration date to “unlimited” respectively.  
 
Notice: Please store your user key in safe place. If you accidentally enter invalid key, the 
license mode is switched back to trial mode! Consequently the license engine will shutdown 
all loaded modules, if the trial period is exceeded. In this case you will need to enter a valid 
user key, to reactivate your license. 
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3  Menu control 
 
This chapter follows the menu structure of Gart-2000® navigation. The menu can also be 
opened with the toolbox button shown above the chapter name: 
 

3.1 Project 
 

3.1.1 Open/Create 1 (Project > Open/Create) 
The projects in Gart-2000® navigation defined as configuration pool with several settings 
for various program modules. Before start using the software, a request for open or create a 
project is prompted. You can perform the same action afterwards using the menu “Project > 
Open/Create”. Creating new or selecting existing one will close the current project. 
 

3.1.2 Properties*2 (Project > Properties) 
At this menu will give you access to meta information about the current project including e.g. 
user data, creation date, size, protocol stack about the last project changes. 
 

3.1.3 Recent* (Project > Recent) 
This menu entry will offer you list overview about recently opened projects with options to 
open them directly. 
 

3.1.4 Exit (Project > Exit) 
Use “Exit” to close the application. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

                                                 
1 The icons represent toolbox button, when available. 
2 All menu entries marked with “*” are in construction and not released yet.  

GART2000® navigation - manual Page 20 von 32 27.10.06 
  Version 1.0 
 



3.2 View 
 

3.2.1 Dockable Window* (View > Dockable Window) 
By means of this menu entry you will have access to all available windows with options to 
open or close them directly.  
 

3.2.2 Toolbar* (View > Toolbar) 
This menu entry will provide you options for toolbar management. Furthermore you will be 
able to personalize your toolbar with shortcuts for any desired menu item. 
 

3.2.3 Statusbar (View > Statusbar) 
With this menu you can enable or disable the status bar of the currently selected window in 
order to gain the corresponding control elements or more view area. 
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3.3 Settings 

3.3.1 General  
Because all the control elements like configuration menus, tool- and status bars, depend on 
the module, you currently loaded and selected, the contents of the main menu “Settings” can 
vary as well. Anyway the following categories are always available: 
 

 Communication 
 Script 
 Messages 
 Logging 
 Main View 

 

3.3.1.1 Design 
For better overview and intuitive handling all configuration dialogs in Gart-2000® 
navigation are constructed with grid layout. Mostly every grid is separated into headlines and 
body fields.  
The headlines describe the structure of the selected module including all corresponding sub 
modules. Thus all configuration values of each and every sub module are represented by the 
columns and the configuration options for the selected setting e.g. “Communication” are 
placed on the rows of the grid. Following picture demonstrates the layout of one configuration 
window: 
 

 
 
Picture 2.3 Communication Settings (Example for configuration window) 
 
 
3.3.1.2 Handling 
All settings are stored in the project database. Clicking “Cancel” will discard the changes you 
took, while “OK” will save them permanently in the project database.  
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3.3.2 Communication  (Settings > Communication) 
 

 
 
Picture 2.3 Communication Settings 
 
This window allows you to set up the settings for your communication device. In this case 
you can configure the RS232 devices of your pc. To avoid incorrect input Gart-2000® 
navigation determinates only available RS232 ports. 

Notice: Although your settings are committed in the project database, the RS232 device is 
configured not before you initialise the current module.  
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3.3.3 Script  (Settings > Script) 
 

 
 
Picture 2.4 Script Settings 
 
Gart-2000® navigation provides you functionalities to send a script file containing 
commands for the attached sensor. The corresponding configuration window offers you an 
overview of the currently selected script files for each sub module. Moving the mouse pointer 
over one of the file-cells will show a tool tip text with the absolute (full) file path. Furthermore 
the last visited folder is automatically reopened, the next time you browse for a script file. 
The second field of settings on this configuration window considers all important file contents, 
which have decisive meaning for the current application task. 
Clicking the button on the file-cells will launch a file browser, to select desired script file, as 
shown on the picture bellow: 
 

 
 
Picture 2.6 Select script file 
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The current path and selected file are displayed on the top of the window. Using the tree 
folder for browsing will display the file contents of the current folder. You can select one file 
and click “View” to load it in external editor or commit/undo your selection pressing “OK” or 
“Cancel” respectively.  
 

3.3.4 Messages  (Settings > Messages) 
 

 
 
Picture 2.5 Message Management 
 
This configuration window provides user friendly access to manage sensor proprietary and 
standard NMEA messages. All available messages are displayed on the rows and listed on 
the headline “Category” respectively.  

Notice: This configuration grid is free extendable to allow fast implementation of new 
messages on request. Experience user can manual take influence on the message set using 
either the script file or internal command terminal of Gart-2000® navigation.  
 
Operating the “Yes/No” switches enables or disables the output of the specific message or 
sets up the logging stream. The Option “Hz” configures the update rate for every message. 
On default output and logging are turned on and the update rate is set to 1Hz. 
On that example the value range for the output rate is linked with the internal position update 
rate for the “Master “- Board of JNSGyro-4. Setting higher rates as the internal configured will 
produce a sensor error or be discarded. To prevent user errors, Gart-2000® navigation cuts 
down the available update rates corresponding to the internal position update rate, that is 
configured with the script file respectively (see 3.3.3 Script   (Settings > Script)). 
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3.3.5 Logging  (Settings > Logging) 
 

 
 
Picture 2.7 Logging settings 
 
Call this window to configure the logging settings for the current module (in this case 
JNSGyro-4). The logging files for each and every sub-module are preconfigured on default 
with standard files stored in the project folder. Pressing the grid cells will launch a browse 
window, where you can select or create new log file. The button “Folder” allows you 
switching the log folder for all files with just one step.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

GART2000® navigation - manual Page 26 von 32 27.10.06 
  Version 1.0 
 



3.3.6 Main View  (Settings > Main View) 
 

 
 
Picture 2.9 Main view settings 
 
The settings for the graphical output screen can be done on this configuration window. 
Clicking the color button will launch a color picker to select new color for the trajectory 
rendering. More configuration options for the main view window can be placed there n the 
future. 
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3.4 Measurement 
The previous chapter 3.3 Settings described the configuration options and how to use them. 
This chapter describes all the actions available on the main menu “Measurement >” based 
on these settings. 
 

3.4.1 Initialise  (Measurement > Initialise) 
After configuring your system, use the menu entry “Initialise” to commit the settings on your 
hardware system. Clicking this entry or the shortcut button on the toolbar will launch the 
initialisation process. On the begging Gart-2000® navigation tries to establish 
communication to the attached sensor via the communication settings you took, after that the 
hardware specific settings are applied on your system.  

Notice: Info messages about the current action and state of initialisation are displayed on the 
left side of the main status bar (see 2.3.3 Program Interface).  
 

3.4.2 Reset Hardware* (Measurement > Reset Hardware) 
Clicking this menu entry will cause to reset the attached sensor.  
 

3.4.3 Tuning and Coordinate Systems  (Measurement > Tuning and 
Coordinate Systems) 

 

 
 
Picture 3.0 Coordinate systems 
 
This configuration window manages the local coordinate systems of multi-antenna 
measurement sensors like JNS Gyro-4. The coordinate systems are defined by the antenna 
offsets of the slave boards in relation to the master board-antenna. The attitude angle offsets 
describe the orientation of the body frame respectively the local horizon and are showed as 
“Pitch”, “Roll” and “Heading” columns on the settings group “Coord. System Offset”. Those 
settings can take float values in the range of -90.0000..+90.0000 degrees. Using them will 
effect to the body frame orientation with respect to the local horizon.  
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Depending on your application task you can easy switch between different systems stored in 
the project database, or create a new one with an appropriate name.  
 
The button “Tuning” will launch a window, responsible for tuning (calibration) tasks to 
determinate the base line coordinates. As known, the attitude angles on multi-antenna 
systems depend on the correct definition of the body reference frame. Thus the base line 
coordinates in the body frame are requested. For this purpose Gart-2000® navigation offers 
you user-friendly interface to perform self calibration of the attached sensor as shown on the 
picture below:  
 

 
 
Picture 3.1 Tuning  
 
The name of the resulting coordinate system is required on the first settings-field. The 
second configuration field “Tuning time [s]” serves to set the processing time for the self-
calibration. This time period should be sufficient large to eliminate slowly varying errors 
caused by miltipath effects. Therefore the calibration time should be in the range between 
~10 min and 120 min. For control issues the update rate of raw measurements is displayed 
on the third settings-field. To estimate the number of measurement samples involved in the 
self-calibration process use following formula: 
 t × u = N; where <t> the tuning time, <u> the update rate and <N> resulting number of 
measurement samples. 
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3.4.4 Log Data (Measurement > Log Data) 
 
 

 
 
Picture 3.2 Log Data 
 
The menu entry “Log Data” provides easy way to activate data logging for the attached 
sensor. To look over the configuration settings for the target log files use “File…”. The current 
state of logging is represented by a check mark placed on the right side of the “Start” or 
“Stop” entries respectively. Activating logging will start writing the input messages configured 
on Settings > Messages (see 3.3.3 Messages  (Settings > Messages)) into the log 
file. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

GART2000® navigation - manual Page 30 von 32 27.10.06 
  Version 1.0 
 



3.5 Processing Tools* 
 
Gart-2000® navigation includes processing tools in order to combine the real time control- 
and monitoring features with post processing functionality. It will contain following 
highlights as described in the list below: 
 

 Extensive data model to response the user requirements for flexible data handling 
and storage. 

 Import / Export interfaces for different data formats. 
 User friendly access to powerful algorithms for complex calculation tasks e.g. 

smoothing of measurement data-raw for accuracy optimization. 
 Tools to perform comprehensive analysis with application data e.g. relation plot of 

trajectories from different measurement sensors. 
 Visualization utilities 
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3.6 Window 
 

 
 
 
Picture 3.3 Window 
 
Gart-2000® navigation is constructed with multi document interface, where every module is 
represented by separate window, menu controls, status- and toolbars. All currently loaded 
windows are listed on the bottom of this menu. Selecting one will activate the corresponding 
module e.g. “Main View” and all his control elements. 
 
Notice: The size and position of the loaded module-window are stored in the project 
database. Therefore the window constellation is saved for each project is saved on program 
exit. Furthermore preconfigured default window constellation is loaded on every  new 
project. 
 

3.7 Help 

3.7.1 Help (? > Help ) 
 
Choosing the menu entry above will run the help documentation. 
 

3.7.2 License (? > License) 
 
(see 2.3.4 Version information and licensing procedure ) 
 

3.7.3 About (? > About) 
 
(see 2.3.4 Version information and licensing procedure ) 
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